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Purpose and Audience

Preface

This preface is organized into the following sections.

Purpose and Audience page v
Before You Read This Book page Vi
Related Documentation page vi
Conventions in Text page viii

This guide shows how to use the Fortran 90 Browser, f90browse to browse
Fortran 90 source code. f90browse , is a part of the f90 package, which
includes a set of application development tools for debugging and
performance analysis They provide a powerful, user-friendly environment for
the development and enhancement of new and existing code.

The guide is intended for scientists and engineers with the following:

® Thorough knowledge of Fortran 90
® General knowledge of some operating system (experience with some OS)
® Particular knowledge of the SunOS™ commands cd, pwd, Is , cat



Before You Read This Book

Related Documentation

manPages

The mancommand uses the
MANPATenvironment variable,
which can effect which set of man
pages are accessed.

See man(1).

Vi

If you are not familiar with Fortran 90, you may want to consult the following.

® Fortran 90 Handbook (Fortran 90 language definition, including intrinsics)
® Fortran 90 Explained (Text book introduction to Fortran 90)

The related kinds of documentation included with Fortran 90 are as follows:

Paper manuals (hard copy)

On-line manuals (AnswerBook)

On-line man pages

On-line READMEdirectory of information files

AnswerBook puts the paper manuals on-line and allows searches of topics. The
system and manuals are included on the CD-ROM and can be installed to hard
disc during installation. Installing and starting AnswerBook are described in
the manual Workshop Installation and Licensing Guide.

Purpose
A man page is intended to answer “What does it do?” and “How do | use it?”

®* Memory Jogger— A man page reminds the user of details, such as arguments
and syntax. It assumes you knew and forgot. It is not a tutorial.

® Quick Reference—A man page helps find something fast. It is brief, covering
major highlights. It is a quick reference, not a complete reference.

Usage

To display a man page, use the mancommand.

Example: Display the f90 man page.

demo$ man f90

Fortran 90 Browser



READMEs

Example: Display the man page for the mancommand.

demo$ man man

Related manPages
The following man pages may be of interest to Fortran 90 users.

f90(1) Invoke the Fortran 90 compiler

f90browse(1) Invoke the Fortran 90 Browser

asa(l) P rint files having Fortran carriage-control

dbx(1) Debug by a command-line-driven debugger
debugger(1) Debug by a graphical-user-interface

fsplit(1) Print files having Fortran carriage-control
ieee_flags(3M) Examine, set, or clear floating-point exception bits
ieee_handler(3M) E  xception handling

matherr(3M) E rror handling

The READMEdirectory has information files: bug descriptions, information
discovered after the manuals were printed, feedback form, and so forth.

Standard Installation Nonstandard Installation to / my/ dir/

Location /opt/SUNWspro/READMESs/ 4 my/ dir/fSUNWspro/READMEs/

File Contents
feedback Sun programmers email template file: Send feedback comments to Sun
fortran-90 Fortran 90 bugs, new features. behavior changes, documentation errata

Preface Vii




Conventions in Text

viii

We use the following conventions in this manual to display information.

We show code listing examples in boxes.

WRITE( *, *) 'Hello world’

Plain typewriter font shows prompts and coding.
In dialogs, boldface typewriter font shows text the user types in.
demo$ echo hello
hello
demo$ m

Italics indicate general arguments or parameters that you replace with the
appropriate input. Italics also indicate emphasis.

For Solaris 2.x, the default shell is sh and the default prompt is the dollar
sign ($) . Most systems have distinct host names, and you can read some of
our examples more easily if we use a symbol longer than a dollar sign.
Examples generally use “demo$ ” as the system prompt; where the csh shell
is shown, we use “demo%” as the system prompt.

A small clear triangle A shows a blank space where that is significant.

AA36.001

We usually show Fortran 90 examples in free form, not fixed form or tab.
We usually abbreviate “ Sun Fortran 90 as “f90”

We usually show Fortran 90 keywords and intrinsics in uppercase, and all
else in lowercase or mixed case.

Fortran 90 Browser




Overview 1

The Fortran 90 Browser, f90browse , provides the programmer with an

interactive environment in which to view and edit application source code.
With f90browse , you can obtain information about many aspects of your
code. This information is available on the routine, file, and program levels.

With f90browse you can do the following tasks:
® Browse Sun Fortran 90 source code.

® Create graphical displays of call trees that enable you to see quickly and
clearly the structure of the code on which you are working.

® Generate information about loops, cross-references, common blocks, include
files, and macro cross-references.

® Combine files into a single application in which multiple files are treated as
a single entity, thus allowing you to trace variables, calls, callers, and other
portions of code on a global basis.

® [ ocate objects when only part of the object name is known.
® Find and display compilation errors.

® Save information (displays and graphs) to files.

® Access other tools.

® Access extensive online help without ever leaving your desk or your
fo0browse session.

1-1
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®* Type commands within the f90browse information panel to speed
execution of frequently performed tasks.

® Customize your interface through X Toolkit options and through the
fo0browse Options menu.

Fortran 90 Browser
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Getting Started

This section explains the following:

Starting f90browse and the fo0Obrowse main window
Opening a file and loading code for browsing
Searching for objects in your code

Saving information to a file

Displaying various call trees

Exiting fo0browse

Understanding CIF file use

2.1 Starting f90browse

You start f90browse by entering the f90browse command:

f90browse &

This command causes f90browse to run in the background and displays the
fo0browse main window on your screen. This window is shown in
Figure 2-1.

Note — Thef90browse displays on your screen may differ from those shown in
this document due to variances among window managers.
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L = fi0browse
File Edit View Find Find All Dizplay Tocls Options Help
Application Name| new., app I |F‘|pplication Hode|
Empty Empty I Empty I
[A [A [A
[/ i [/
| File | Hone I | Foutine | Hone
1 A
2 FFFFFF 933933 Jals] BEER FRERE 1] Wl W 5555 EEEEE
3 FF 99 99 oo o0 BE BE RE RR OO0 00 LW Wl 55 EE
4 FF 93 93 oo o0 BE BB RE RR 00 00 MWW Wl 55 EE
5 FFFFF 993333 00 00 BEER FRERE. 00 00 MWW WY WY 55 EEEEE
E FF 93 00 00 BB EE RR RR 00 00 LW WW MW 55 EE
¥ FF 93 00 00 BEE EE RE RR 00 00  WWWWLWLWNY 55 EE
a FF 99 Juli] BEER FE RRE 00 Wl Wl 5555  EEEEE
9
10
11 Pleaze select one or more source files to work with by 3
12 |
13 . Typing "open filename" within the "Information" window below
14
15 . Using the "Open..." option from the "File" pull-down menu
16
17 For help, select "Help,.," from the "Help" menu, or
18 type "help" below,
19
e
pal
22
23 fz
[ Jo
| Informat.ion
faobrowse wersion 1,0

Figure 2-1 Main f90browse window
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The main window is composed of the following segments:

Menu bar — The menu bar is located at the top of the main window and
displays buttons that open f90browse menus. To open a menu, position the
cursor on the menu name and press the left mouse button.

Upper display panel — The upper display panel is composed of three separate
information lists that display names of loaded files, routines, common
blocks, and so forth. All lists have vertical scroll bars on the right. If
information in a list exceeds the width of the listing area, a horizontal scroll
bar also is displayed.

Source code display — The source code display is located in the middle of the
foObrowse window and is the largest area of the window. This display
shows the source code you are currently browsing.

Information panel — The information panel is located at the bottom of the
main f90browse window and provides you with information about the
status of f90browse . You can also type f90browse command equivalents
for many menu options in this panel. (A list of these commands is
available through the Help menu option.)

Although f90browse is contained within a single window, you can move
some screen segments off the main window to create separate windows that
you can then resize, reposition, and economy. Moving a segment off the main
window is referred to as peeling off the window segment.

Screen segments that can be peeled off display a peel-off icon in the upper-
right corner. One example of using a peel-off window is shown in subsection
Section 2.4, “Saving Information.”

Getting Started 2-5
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2.2 OpeningaFile

To open a file, position the cursor on the File menu button and press the left
mouse button to open the menu. (This is also referred to as clicking on a
selection.) With the menu displayed, click on the Open option. A popup
window is displayed on which you enter the name of the file (or files) to be
opened. Figure 2-2 shows this panel.

) fa0browse Load File !

Load Filename

H #home/nipper8F 90brdemo, %

|Filename Filter [wildcard replacement for % and 71

[ %

Directories Files

atuxdemo, T
atuxdemo, f

Load | Filter | Clear I Elosel

Figure 2-2 . Open display

Enter the file name(s) on the top input line and click on the Load button or
press [RETURNto open the file(s). You can use wildcards when entering file
names. To enter multiple file names, separate each name with a space. If the
name of the file you want to load is displayed in the Files list, simply use the
left mouse button to double click on the file name to open the file. When the
file is loaded, f90browse displays it in the source code display as shown in
Figure 2-3.

Fortran 90 Browser
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File Edit Wiey Find Find All Dizplay Tools Options Help
Application Namel new, app | |prli-:atic-n Hndel
Loaded Files I Routines:Application I Commons:Application I
S, b {/home/nif (2 | ATHIEHD * ATH
ELLER EULERCOM
ELLERY TIMEDATA
HEHRATE
PHRCASE
PHRCASEX
PEAKATY
e POORPERF
[ | reporT —
I{] | i).% STATE X
| File | atxdemo, £ | | Routine | None
1:|C USMID Bi#) xbrowsesatxdemo,f 80,1 050094 03313112
2:|C
EH (C» COPYRIGHT CRAY RESEARCH. IMWC,
4:|C UWPUBLISHED PROPRIETARY IWFORMATION,
qi|C ALL RIGHTS RESERYED,
Bi|C
7
g PROGRAM ATHXDEMD
EH =
10 dimenzion mcil28} JEOE1RE3
11:|C
12 FARAMETER ¢ ITHAX=200
13 dimenzion EXTIMES ITHAK
14 common Satxd allood
15 PARAMETER ¢ IGMAX=9B6, JGMAX=18, KGHMAX=18) Je101288
16 COMMON AEULERCOMS W IGMAX . JOMAX , KGHAKB) .
17 N Db TGHAK, TEMAK , KGHAK 53,
13 . KOIGHAK , JEHAK, KGHAK .52
13:|C
20:|C
21 call gethmc{mc) JKOE15E3
22 clkratesmci7 ) *l,e-12 JkOE1RE3
23 y
K] [
| Information |
f30browse version 1,0
Opening file @ "/homesnipper/fI0brdemosatxdema, £",
"atxdemo,f" was compiled with a Fortran 90 compiler, for a SPARC architecture,

Figure 2-3 atxdemo.f file opened
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2.3 Looking for Objects

A common activity while browsing code is to look for various types of objects.
The following list names just a few of the objects you can locate using
f90browse

Calls and callers
Common blocks
Loops

Routines
Variables

You look for routine-based information by using Find menu options. Find All
menu options let you look for file- or application-based information. Most
options work in a similar manner, so trying a couple of searches will give you
an idea of how to find objects in your code. The next two subsections illustrate
how to find loops and external calls in our sample Fortran program.

2.3.1 Finding a Loop

Because loops are displayed by default when a routine name in a Fortran file is
selected, finding loops is very easy. To display loops, click on the routine name
for which you want information displayed. Loop information is displayed in
the center information list of the upper display panel and the area of your code
where the loop occurs is highlighted in the source code display.

Figure 2-4 shows loop 1010 of the MAXRATEoutine selected in the information
list with the area where the loop occurs highlighted in the source code display.
The information list shows the following information about the selected loop:
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Value Description
1010 Loop label. If a loop has no label, the wammbp is displayed.

75 - 80 Starting and ending line numbers.

1 Nesting level. A nesting level df indicates an outer loog, indicates a
single nest, and so forth.

] T90browse
File Edit View Find Find ALl Display  Ieols  Opkiors Help
[Application Nane | el 3PP | [feplication Hode]
Londed Files | L oops: HEHRATE 1G] Commons; HARATE |§E|
R e 000 g5- 711 TINEDATA [&
B T
030 0t~ 0 1
W0 8- 87 2
2020 105 - 112 1
10 106 - w1 2
2040 116 - 123 1
2080 117 - 122 2
2060 123 - 143 1
K T 2080 130 - 148 2 o
[Fite | Sixdenn b | [ Routine VRRRATE | ]
55 15 = JETIW & 113 [&
53 b S TETIN ¢ 1
6o [
Biifc
B2 |C ®% [EFIME THE INITIAL VALUE
63 [c i
B4 [C- HORIZONTAL BOUNDARY YALUES
]
I 0 1000 T = 1,1
67 1.1} =10
50 UL R +L o
63 EILL = Lo
70 DNEU: T ey = 1o
71| 1000 conrTvoE
2l
73 [t veRTICHL BOUNTERY weLUES
nife
|
[ Infarnation |
Fa0browse version 1.0 [&
Dpening fils ¢ "/homeénipper f30brdsnn/stdsnn, £,
"atixdemn, £ uss cowpiled with & Fortran 90 conpiler, for s SPARC srchitesturs,

Figure 2-4 Loop option output
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2.3.2 Finding External Calls

The Externals  option of the Find All menu lists external calls in a file or
application. (An external call is one for which f90browse does not have the
source code loaded.) Because external calls are not displayed by default, follow
this procedure:

1. In the upper display panel, click on a file name to select the file.
2. Click on the Find All button to open the menu.
3. Click on the Externals  option.

The Externals  option displays the names of external calls in the upper
display panel. To view every occurrence of an individual call, select an external
call by clicking on the call name; each occurrence of the call is highlighted in
the source code display.

Figure 2-5 shows output from the Externals  option for the atxdemo.f file.

Fortran 90 Browser
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File Edit Wiew Fird Find Al Display  [eels  Options

Help

call ge nc
22 clkrate=mc{7)kl.e-12

[

[Aeplication Hame] new, app | [AepLication Mode]
Externssfpplication | g Laops: HAKRATE | Commansz HRARATE | (]
FTROEHD T CETHE 06— 71 1 i|ay [Tmevama 2
3 R
Tos B4 - o9 1
100 8- 87 2
220 105 - 112 1
2010 106 - 111 2
2040 106 - 123 1
2030 107 - 122 2
2060 123 - 149 1
2050 130 - 148 2 =
[Fils e | [Routine | ATAbErD
T[T USHID @) wbrowse/atadena, P 80,1 0505754 0:15:12 A
B
B () COPYRIGHT CRAY RESEARCH, INC,
e UNPUBLISHED PROPRIETHRY TNFORHATION,
5 ALL RIGHTS RESERVED,
6l
7
9 PROGRAH ATHDEHD
sile
10 dinension ne(128)
1o
2 PARANETER ¢ ITHEX=200
5] dinension EXTINECITHAXY
o common ate/ at1000}
15 PARANETER ( TGHFU(=98, JGHAK=18, KGHAK=18)
15 COMHON AEULERCOY W TGHRI, JGHAX, KGR, 5),
17 . DUCEGHAN, JGHAX KGHAR )
13 . HETGHEK, JGHA KEHAK 5)
s
201 [c

[ Information

Opening file : "/hone/nipper/f30brdemos/atxdemo.f",
"atxdemo.f" was compiled with a Fortran 90 compiler, for a SPARC architecture,

There are no wore highlighted areas below this point,

T Pl=

Figure 2-5 Externals  option output

2.4 Saving Information

f90browse makes it easy to save output from menu options by using the peel-
off feature, which was introduced on page 2-5. Information displayed in any

segment of the f90browse window that you can peel off can be saved to a file.
For example, to save the MAXRATHoop information shown in Figure 2-4, refer

to the following procedure.
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1. Position the cursor on the peel-off icon located to the right of the
loops:MAXRATE title bar (shown in Figure 2-4 on page 2-9) and press the
left mouse button. When you select Save List , a popup window opens
that allows you to choose among several options.

I E] fa0browse Save List b
|Saue the information list Fnr| | Loopz:HRXREATE |
T | o

Save | Clear | Cloze |

Figure 2-6 Save List  display

2. To save information to a file using the default file name, click on the Save
button. To change the file name, click on the Clear button to erase the
default file name and then enter a new file name.

3. After you enter a new file name or use the default name, click on the Save
button to save the information.

Note — Unless you specify a full path name for the file, files created from this
type of save operation are saved in the directory from which you invoked
f90browse

4. Click on the Close button to close the display.

Fortran 90 Browser
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2.5 Displaying Call Trees

Call trees make it easy to see the structure of your code through a clear graphic
format. The Display menu provides you with the following two call tree
options:

® Call Tree
® Caller/Call Tree

fo0browse gives you visual clues to help you identify various parts of your
code within the call trees. On monochrome screens, external routines are
marked with an E following the routine name and intrinsic routines are
marked with an | . On color screens, external routines are shown in green and
intrinsic routines are shown in yellow. (An external call is one for which
f90browse does not have the source code loaded.)

2.5.1 Call Tree Display

The Call Tree  option produces a static call tree of loaded source code. The
name of the application or file used by this option is shown at the top of the
display and called routines and subprograms are displayed in the middle.

The small, empty boxes following some nodes (routine names) on the tree
indicate there are subtrees that stem from these nodes. To open the tree one
level, position the cursor on the box and press the left mouse button. To close
the tree one level, position the cursor on the node name and press the right
mouse button. When you click on a node, that node becomes the current node
and is displayed in the main f90browse window. To close the display, click
on the Close button.

Figure 2-7 shows the application call tree for ATXDEMQvith the STATEroutine
opened up one level.
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[r E fa0browse Application Call Tree

|prlication Call Treel

= |
GETHHC (E7
THTE H
RARATE
EFORT
TEFCASE |
EAKAT |
OORFERF |
ARCASE |
ARCASEX |
AF

ULER |
OLERY |

lil “l “l Ii! “l “l
1 I

mi{=
—
—_
—

i

L]

7

1<l

[

| External Routine | | Intrinzic Routine |D | Search Mode |

“T - Taggle ™5 - Search “H - Hide “E - Expand lewel
Mouze Button 3 1ileft) - Select node 3lright) - Toggle subtree

Sauel K ./rew,app_treell

b

Clogse

Figure 2-7 Sample Application Call Tree
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2.5.2 Caller/Call Tree display

The Caller/Call Tree option displays a static call tree of routines that call
a specified subprogram and, in turn, displays any subprograms called by the
specified subprogram. Selecting a node on the tree highlights the subprogram.
The name of the source file (or the application when in application mode) used
by this option is shown at the top of the window. Calling sequences are
displayed in the middle of the window. To close the display, click on the Close
button.

Figure 2-8 shows sample output from the Caller/Call Tree option. In this
example, the STATEroutine is called by ATXDEM@nd calls both the CLOCKand
DATEroutines.
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=] fa0browse Application Call/Caller Tree L
||’-‘|pplication Call/Caller Tree|
[A
z D]
ATATIEMD STATE :
‘
¥
K [
|Exter‘nal Routinel | Intrinszic Routine|
Save | |§./mew,app_callerll B Close I
Figure 2-8 Sample Caller/Call Tree display

2.6 Exiting f90browse

To exit the f90browse tool, select Quit f90browse from the File menu.
f90browse displays a popup window on which you can confirm or cancel
your decision to exit.
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2.7 CIFFiles

Compiler information files (CIFs) are generated by the Fortran compiler and
contain information about source code. Depending upon the options you select
on the compiler command, a CIF may contain information about the
characteristics of the machine for which the code was compiled; information
about variables, constants, name lists, labels, loops, and procedures; cross-
reference information; and compiler messages. f90browse obtains information
about source code from CIFs generated by the compilers. These files are named
filename.T .

2.7.1 Generating CIFs Before Starting f90browse

If a CIF exists for a particular source file, f90browse will use that file. If no
CIF exists, or if it is found to be out-of-date (that is, older than the source file),
fo0browse creates a new CIF by invoking the proper compiler for the source
file. You can decrease f90browse start-up time by using compiler options to
generate CIFs before you start f90browse.

Individual compiler options are as follows:

Compiler Option
Fortran 90 -db filename.f

If you compile your code with the compiler option on, f90browse reads from
the already created CIF rather than creating a new CIF when you invoke the
f90browse tool.

fo0browse creates a binary format of the CIF file and adds a file extension of
.TT to the file name. By default, these files are created in the same directory as
the source code.

Getting Started 2-17
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You can, however, specify that all CIFs created by f90browse be placed in the
directory pointed to by the CIFDIR environment variable as shown in the
following examples:

mkdir /tmp/cifs (csh users)
setenv CIFDIR /tmp/cifs

mkdir /tmp/cifs (ksh and sh users)
CIFDIR=/tmp/cifs
export CIFDIR

In these examples, all f90browse -created CIFs will be placed in and read from
the /tmp/cifs directory.

2.7.2 Generating CIFs in the Background

By default, f90browse creates a CIF as a foreground process, thereby stopping
all other activity within the tool until the CIF has been created. If you want
CIFs to be generated in the background, set the NPRO@&nvironment variable to
a value greater than zero.

Fortran 90 Browser
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Getting Help 3

The online help system available within f90browse puts information at your
fingertips with the click of a button and ensures that help is always available
when you need it. The Help menu gives you easy access to information about
every aspect of the tool. By selecting among the following menu options, you
can view documentation online without ever leaving your f90browse session:

Help

Context Sensitive
Man page

About f90browse

The Help option displays in the main window. It displays an online file with
complete information about f90browse . You can think of this option as a
replacement for the usual paper documentation. It contains information about
the following topics:

® Information that introduces the various portions of the f90browse window
and helps you understand how to navigate through f90browse

® Full descriptions of all available menu options

3-19
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® Lists of X Window System Toolkit options and environment variables
available with f90browse
® A list of command equivalents for menu options

3.2 Context Sensitive

3.3 Man page

Context-sensitive help provides information relevant to the area of the
fo0browse window in which your cursor is positioned. When you select
context-sensitive help, f90browse displays a popup window that gives a brief
description of the area of the window on which the cursor is positioned. You
can think of context-sensitive help as an online quick-reference guide.

Because output is displayed in a separate window, you can resize, move, and
iconify the display. In addition to clicking on the menu option, you can display
Context Sensitive help by pressing either the [FI] key or the key
designated as the [HELH key on your workstation.

When you select this option, f90browse pops up a window on which to enter
the name of the man page you want to view. The man page is displayed in the
main f90browse window. In addition, by using the peel-off feature, you can
save man page output to a file and print the contents.

3.4 About f90browse

3-20

When you select this option, f90browse displays version and copyright
information about the tool.
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application mode

button

call tree

click

compiler informa-
tion file

external call

information panel

menu buttons

Glossary

The mode in which two or more files are combined so that many f90Obrowse options
apply toan entire program rather than to an individual routine. This is the default mode
of f90browse

An icon that allows you to open menus, execute commands, and display popup win-
dows. To activate, position the cursor on the button and press the left mouse button.
(This is also called clicking on a button.) Buttons may be boxed as are the Load, Filter,
Clear, and Close buttons of the Open display shown in subsection Section 2.2, “Opening
a File,” on page 6, or they may be unboxed as are the menu buttons at the top of the
main f90browse window.

A graphical display of selected source code in which the name of the source file is shown
atthetop ofthef90browse display and called routines and subprograms are displayed
below.

To press a mouse button once and release it without moving the pointer.

A file produced by the Fortran 90 compiler that describes a source file. Depending upon
compiler options, this file may contain information about procedures, variables, con-
stants, labels, compiler messages, cross-reference information, and so forth.

A call to a subprogram for which f90browse does not have the source code loaded.

Screen area located at the bottom of the main f90browse window that displays ac-
knowledgments, messages, and errors. You also can type f90browse commands in
this panel.

Buttons located on the menu bar at the top of the main f90browse display. Clicking
on a menu hame (button) opens the associated menu.
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node
peel-off capability

popup window

source code display

source file

upper display panel
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A point defined by a unique name.

Allows you to convert a screen segment into a separate X Window System window that
can be moved, resized, iconified, or otherwise manipulated in the same manner as any
other X Window System window.

A window that is displayed to perform a specific function and that is then dismissed.

Screen area located in the middle of the main f90browse window that displays the
source code you currently are browsing.

The actual code being examined by f90browse

Screen area located near the top of the main f90browse window that displays three
information lists that contain output from menu options.

Fortran 90 Browser
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Context-sensitive help 20 using to reduce start-up time, 17
Copyright information Compiler options, 17
displaying 20 Context-sensitive help, 20
Help . conventions in text, viii
context sensitive 20 . . .
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online 19 displavi 20
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viewing through xbrowse 20
Online help 19 D
Version information Definition
displaying 20 clicking, 6
compiler information file, 17
A external call, 10
addenda for manuals, read me file, vii information panel, 5
menu bar, 5

audience, v peel-off icon, 5

peel-off window, 5
C source code display, 5

Call trees upper display panel, 5

types, 13
Commands E
entering in the information panel, 5 email

fo0browse, 3 send feedback comments to Sun, vii

comments - errata and addenda for manuals, read me
to Sun, vii file, vii

Compil_er_ir_1f0rmation file External calls
deflnltlt_)n, }7 definition, 10
generating in the background, 18 finding, 10
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E

f90browse
exiting, 16
main window, 4
starting, 3

f90browse command, 3
feedback file for email to Sun, vii

Files
T, 17
TT, 17
information files, vii
opening, 6
saving output to, 11
font conventions, viii

H

Help
context sensitive, 20
online, 19
types available, 19

Information
about external calls, 10
about loops, 8
files, vii
saving, 11
Information panel
definition, 5
typing commands in, 5

L
Loops, finding, 8

M
Man pages
viewing through xbrowse, 20
man pages, Vi
Menu bar, definition, 5

Fortran 90 Browser
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on-line documentation, vi
Online help, 19
Output, saving, 11

P

Peel off
icon, example, 5
window, definition, 5
windows, usage, 5
windows, using to save
information, 11
prerequisites, v
prompt conventions, viii
purpose of manual, v

R

READMEs, vii

S

Saving output to a file, 11
Source code display, definition, 5

standard
conformance to standards, vi

Sun, sending feedback to, vii

T

triangle as blank space, viii

U
Upper display panel, definition, 5

\Y

Version information
displaying, 20
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